Getting started with Quite Hot Imposing

This document introduces the concepts of Quite Hot Imposing, and describes how to set it up
with Hot Folders. Not all users work this way, especially if integrating with Enfocus Switch
or using the command line. This document does not talk about creating the sequences of
commands which actually do the work. Please see

e https://www.quite.com/docs/qi6/en/qi6_manual/ (full manual)

e https://www.quite.com/docs/qi6/en/ghi6_variables/ (details of new variables feature

for 6.0)
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Quite Hot Imposing - General
Applying Impositions

The easiest way to understand Quite Hot Imposing is to work with Quite Imposing Plus for a
while. All of the imposition functions in Quite Hot Imposing are identical to those in the
plug-in. It is also quicker and easier to see the results of an imposition when it is run on an
open document in Adobe Acrobat.

Impositions can be completely set up in Quite Hot Imposing, but it may be harder to visualise
the results when this is done.

In either case, an imposition is a series of one or more commands. For example, you might
shuffle the pages of a document into the order required (also rotating some of them), using
the Shuffle Pages command. Then you might use the N-Up Pages function to arrange these
pages onto sheets. More complicated impositions might add page numbers, shift pages to
allow for binding (“creep”), or insert a cover page using the “background” feature.

Once an imposition has been made in Quite Imposing Plus, it is immediately available for use
in Quite Hot Imposing in several ways:

e The PDF file you made contains full details of the command used. You can save the
PDF then use it as a control file in Quite Hot Imposing.

¢ You can export these commands as XML (from the Info panel). This too can be used
as a control file.

You can import commands into automation sequences in Quite Imposing Plus. This is
particularly flexible as you can test the automation in the plug-in. For each set of commands
you import, you choose a name and category. (The category is anything you choose, to help
organise large sets of commands). The automation sequences you set up in Quite Imposing
Plus are available immediately in Quite Hot Imposing.

Ways to run Quite Hot Imposing
Quite Hot Imposing has different modes of operation. They include

e Running with hot folders. We call these queues, and each queue has four folders (IN
and OUT, a DONE folder to keep the input, and an ERROR folder). You can set up
multiple queues, which can run either automation sequences or XML control files.
The queues (in 6.0) can have filters on the name so you can control the work through
the file name.
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e Run with the command line interface (CLI). The command line is the engine which
always does the work, whatever the mode, and you can run it directly. It always runs
just one job, then finishes.

e Run through integration with another product, notably —

e Run through integration with Enfocus Switch. Switch provides a workflow and you
can call Quite Hot Imposing at any point, specifying the control file to use. You can
optionally pass private data as variables into the job, and get information back into

private data. You can optionally use Switch Datasets for purposes like sheet
backgrounds, variable data source, or more.

Quite Imposing Plus functions not available

A few of the functions of Quite Imposing Plus are not available in Quite Hot Imposing. These
are the functions which work with more than one file (since Quite Hot Imposing is always
one file in-one file out); and the functions which depend on a knowledge of the “current
page”, since there is no idea of a current page in a batch program.

The main functions not available are:

e Manual imposition to overlay an existing document. (Manual impositions to a new
document or background can be used to make complex layouts for imposition).

e Shuffle even odd functions that split or merge files.

e Booklet making options that produce two files.

e Join 2 Pages (since it joins the current page) except for files with exactly 2 pages.

e Various Insert Pages options related to the current page (e.g. insert before current
page, make page the same size as current), and the Insert Page option to make a new

document.

e Options in any command to work on the “current page”. Use a specific page number
instead.

Quite Hot Imposing — filename filters (6.0)

Before version 5.0 only one queue could be active on the same input folder. (You could
define multiple queues with the same input folder, but only one could be active at a time.)

Now, in 6.0, you can set filename filters on each queue. These allow the queues to choose
work based on the filename. For example, you could set up four queues on the same folder

1. Filter BOOK A4* (the asterisk * is part of the filter name). This picks up all files with
names starting BOOK A4 and does work suitable for an A4 book.
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2. Filter BOOK AS5*. This picks all files starting AS.

3. Filter *MONTHLY*. This picks up all files whose names contain MONTHLY. It
won’t pick up the BOOK A4 and BOOK A5 files, since the first match found is the
one that is used.

4. Filter *. This picks up all files, or rather all the files not picked up by any other queue.

The filters on each input folder are independent of each other. Setting a filter is optional. If
you do not set a filter, the original rule — only one active queue per input folder — still applies.

Quite Hot Imposing — XML editing (6.0)

Working with named automation sequences has been simpler than working with XML, which
before version 6.0 needed to be exported from and imported to automation sequences. But
some customers want or need to work with XML, especially those using Enfocus Switch or
the command line. There have been two improvements to make this task simpler in 6.0.

First, the File menu now includes New XML and Edit XML. These edit the list of commands
exactly like automation sequences, but end by prompting to save a file.

%1 Quite Hot Imposing - O
File = Edit Control Help
Mew XML file...

Edit XML file...

Exit

1: Action.. | Ready | S&R variable size3
Second, the screens to set up an XML file allow editing and creation of an XML file.

Selecting a control file

You can select either a PDF or XML file to control the imposition. The file must have been created by Quite
Imposing Plus

Browse.. | Controlfile:  C:\Usershaandi\D ownloads\Flatwork - 1218 Dynamic.xml

To create or edit XML click  Create...

To review the commands in this file, click  Details...

Recent files... | Choose a recently used XML file

If you use Save As to save a new name, you will be asked whether this is to become the
current XML file for this queue. This is also available on the Action menu from Change
XML control, without needing to go through the other setup screens.

Other Documents Available
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In addition to this document, a number of other documents will be installed on disk. These
can be found in the docs folder, which can also be reached from the Help menu or “?” button.

command line spec.pdf — explains how to run impositions from the command line (for
advanced users)

Quite Hot Imposing Hot Folders

Hot Folder Concepts

Quite Hot Imposing lets you work with hot folders, also called watched folders. These are
found in many products, but there may be differences in Quite Hot Imposing, so it is worth
checking this section even if you are familiar with other products.

Quite Hot Imposing allows you to set up multiple hot folders. In fact, each setup (called a
queue) has four different folders:

The IN folder: PDF files to be processed are put into this folder. Quite Hot Imposing
never puts files into here, but will take them out.

The OUT folder: the resulting file, after doing the work, is put here. This is typically
an imposed file, such as a booklet layout. The name will be the same as the original
file.

The DONE folder: the original file is moved to here, unchanged. This is done so that
Quite Hot Imposing does not destroy any files. The file will only be moved to DONE
when processing is successful

The ERROR folder: if a file cannot be processed, and doesn’t make a file to put in
OUT, we have to do something with it, rather than just leave it in the IN folder.
Otherwise, it would be processed again right away! So files which fail are moved to
ERROR.

Important: these folders can have any name, not just IN, OUT, DONE, ERROR. These are
the default names used by “Express setup”, but you are not limited to these names.

To summarise the flow for each queue:

1.

2.

3.

4.

Files appear in the IN folder.
Quite Hot Imposing attempts to process them to make an imposed file.

On success, the files from IN are moved to DONE, and the imposed file is put into
OUT.

On failure, the files from IN are moved to ERROR.

Important Points in Choosing Hot Folders
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Network Use.

Any hot folder can be on a network drive. However, we recommend you consider using a
local drive instead, for the following reasons.

1. The hot folder process can fail or hang if the server containing the folder is
unavailable. The risk increases if multiple hot folders on different servers are used.

2. On the Macintosh, you will need to make sure that the hot folders are mounted before
starting Quite Hot Imposing; similarly on Windows if drive letters are used rather
than machine names. On the Macintosh, using the same share name from different
computers will cause confusion, as Mac OS X may change the disk names as seen by
Quite Hot Imposing.

3. Watching a folder on the network may generate a lot of extra network traffic, since
the server must be asked constantly if there are new files. Consult your network
administrator about the effect this may have.

4. Writing output files to the network may be much slower than writing to local disks.

5. Care needs to be taken to make sure that the user who runs Quite Hot Imposing is able
to write, rename and delete files in the shared folders.

IN, DONE and ERROR on the same disk.

It is important to use the same disk (or network share) for the IN, DONE and ERROR folders
for a single queue. This allows the input file to be quickly moved from IN to DONE on
success or from IN to ERROR on failure. Trying to set these up on different disks may fail.

Limitations
License

The normal software license only allows the software to run on one computer, and does not
allow it to process work from other sites or from the internet, or to be part of a process to
automatically send imposed files off site.

Unique IN Folders.

Y ou must not normally use the same IN folder for different active queues. The folders work
independently, and would both try to process the file at the same time, but only one would
win. If you do set up several queues with the same IN folder, the software will automatically
make sure only one is active at a time. If you want to do this, it may be helpful to set the
Preferences option Show enable/disable check box for each queue, to allow queues to be
turned on and off more quickly. It is possible, and reasonable, to use a single folder as the
OUT folder for several queues.

A new feature in 6.0 is filename filters. These allow each queue to work only specific file
names given as a pattern with * included. In this case you can have many different queues

Quite Hot Imposing 6 Getting Started Page 6



with the same IN folder. Quite Hot Imposing works through the queues in order until it finds
one with a matching filter. Only the first queue with a matching filter is used.

Single PDF File Input

Quite Hot Imposing generally processes a single PDF file to make a new PDF file. However,
you can use a feature called “job folder” which allows you to provide a whole folder. All the
PDF files in the folder are automatically combined first, then the single file is processed. (It
does not process the files separately). The filename filter can be used to select files or folders.

The only type of file accepted in an IN folder is a PDF file. Quite Hot Imposing does not
convert any other kind of file to PDF. A job folder can contain certain other files with special
purposes, but it does not convert any files to PDF; only PDF files are combined and
processed.

Single PDF File Output

Quite Hot Imposing will normally produce a single output PDF for each input. The input
might be a single PDF file, or a job folder with PDFs to be combined. Starting in 5.0, the
Split/Merge (partials) command can be used to generate an unlimited number of separate
files. This command must be the last one in any control commands.

The Split/Merge (partials) command allows you to set the rules for naming the output. You
can choose whether the parts appear separately in the OUT folder, or whether a single folder
is created in the OUT folder containing all the parts.

No Printing

Quite Hot Imposing writes PDF files only. It does not include any method for printing files.
Many high-end printers and imagesetters will work with their own hot folder system, and so
they can be set up to look for files in the OUT folder(s) of Quite Hot Imposing.

PDF Version

PDF files are identified by a version number, such as PDF 1.3 or PDF 1.6. Your other
software may have limitations on the versions of PDF that it accepts. At the time of writing,
PDF 1.7 files should be processed without errors. Optionally, Quite Hot Imposing will also
preserve PDF/X mode (a stricter set of rules for PDF files).

Quite Hot Imposing attempts to set the output PDF to have a suitable PDF version. Usually
this is the same as the input PDF. However, using background PDF files would force Quite
Hot Imposing to set the output file to use the highest PDF version.

The PDF files to be imposed must not have password or security options applied. PDF forms

made with the Adobe LiveCycle Designer product cannot be processed. Digitally signed PDF
files may be locked too.
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Must Be Running (for queue processing)

If you are working with queues, Quite Hot Imposing must be started on your Windows or
Mac monitor. Work will only be done as long as it is running. It always displays a status
window (though this window can be minimized).

If you are using the command line (CLI) or Enfocus Switch, Quite Hot Imposing does not
need to be running. However, you may need to run Quite Hot Imposing for these purposes:

1. To enter your license information. If you do not see a Licensing button, click the ??
button. Neither command line nor Enfocus Switch will work until you have entered a
license.

2. Quite Hot Imposing (6.0) can edit XML control files directly using File > New XML
file and File > Edit XML file. These control files must be specified on the command
line or with the Enfocus Switch flow element setup.

3. For convenient access to online help or to check for updates (? button).

Setting up hot folder queues

Quite Hot Imposing allows you to set up many different queues, each with its own set of four
folders (IN, OUT, DONE and ERROR) and each of which may perform a different
imposition. You can also turn off particular folders temporarily. In this image, Quite Hot
Imposing has already been set up with 4 named queues.

U

File Edit Control Help

| Quite ¥

1: Action... Ready  5&R variable size3 ~
2: Action... = Working Dup pages 17 Good=1

3: Action... Disabled Generate bleed & booklet

4 Action... Broken  Egress 27 Good=0, |

2 ... There were warnings:

2 .. Warming, prerelease beta will not work after 31 May 2025

4: Could not move input file Zample document 1-03.pdf to emror - perhaps i

4: W arning: File may be processed again when it is closed.

4; Could not remove previous output file Zample document 1-03. pdf - perki

Thiz iz a time limited prereleasze beta and will not work after 31 May 2025, i
| Quit. . ‘ 7| b

-

Add... | Prefs... Pauze
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To add a new hot folder you can click the Add button (if shown) or use Control > Add Hot
Folder. Each hot folder you add will appear as a line in the main Quite Hot Imposing
window.

Each queue has a number, which appears in the log to identify the work done. (Deleting a
queue will change numbers). There is an Action button to choose what do to with the queue
(enable/disable, change settings, view folders and more). Each queue has a field showing the
status (Enabled/Disabled/Active/Broken), and you can click on this field to quickly enable or
disable the queue. Finally, in each line you see the name of the queue, which you can change
but defaults to the sequence or XML name.

Note that files which get an error in imposition (for example, a file which tries to duplicate
page 27, but has only 26 pages), does not cause the queue to stop. Instead there is an error
message and the file is moved to the ERROR folder. A queue is only marked “broken” if it is
unable to continue, for example if a folder is deleted, or a file cannot be deleted — perhaps
because it has been opened in Acrobat.

To change the settings for a hot folder, or to remove one, click the Setup button for that

folder. In either case, a series of three dialogs will appear, to choose the hot folder, to select
the imposition, and then to set other options.

Choosing Hot Folders

®1 Add a hot folder queue - 1 *
The first step iz to choosze the hot folders. There are four in all. Fefer to the picture to see how the four folders

! ., are connected.
> The zimplest way to set up the
hat folders iz to use Express
Setup. You can then uge the
buttons below if any

‘L adjustments are needed.

POF
I peiad
Fnalt FOF Express setup...

Advanced directany setup

Browse... | Input folder:
Browse... | Output folder:

Browse... | Done folder:
Erowse.. | Emor folder:

Click Mext bo continue,

‘ Cancel
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In this dialog, you choose the four folders to be used (IN, OUT, DONE and ERROR) for a
single queue.

The quickest way to set up the four folders needed is to click the Express Setup button. Select
a folder (the option to make a new folder is available), and four new folders will be created
inside that folder, called IN, OUT, DONE and ERROR. These four folders will be shown in
the dialog, and can be separately changed if required (but changing them will not delete any
folders that were created; the created folders will just be ignored).

You can also click the browse button to set up folders individually. You do not need to use
the Express Setup button, and you do not need to call your folders IN, OUT, DONE or
ERROR. The folders do not need to be grouped in the same place.

The IN folder is typically unique to the queue, but the OUT, DONE and ERROR folders can
be shared between queues.

When the four folders are selected, click Next.
Selecting the Imposition
On this dialog, you decide what imposition is to be done using the hot folders you just

selected. You can either use a control file, or use a named sequence set up with the Quite
Imposing Plus plug-in. Once you have made your selection, click Next.
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Selecting an XML file

%) Modify a hot folder queue - 2 X

. . The second step is to choose the work which will be done when a PDF file arives in the 'in’ folder. This is
k\ , usually done by taking an imposition prepared earlier.

& Use an existing PDF or XML file to control the hot foldes

" Use named automation sequences (compatible with Quite Imposing Plus)

Selecting a control file

You can select either a PDF or XML file to control the imposition. The file must have been created by Quite
Imposing Plus

Browse... | Controlfile:  C:\Users\aandi\D ownloads'\Flatwork - 12x18 Dynamic. xml

To create or edit XML click  Create... | o Edi..

To review the commands in this file, click  Details... ]

Recent files... | Choose a recently used XML file

Filter on filename

If you set a filter, the queue will check and only run files that match. If you have variables, you can also set
variables in the file name

Fiter: Setup... | Handles files: *-3by2*

Click Next to continue.

Nest Back | Cancel I

Click the Browse button to select a control file, or Recent files to choose an XML you
selected recently. This may be an XML file or a PDF file produced by Quite Imposing Plus
version 2, or from Quite Hot Imposing itself. Any imposed PDF file can be used as a control
file.

You can also click Create or Edit to create or edit an XL control file.

The Details button can be used to review full details of the imposition stored in your control
file.
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Selecting a Sequence stored in Quite Imposing Plus

.' The second step is to choose the work which will be done when a POF file arives in the 'in’ folder. This is
\,, , usually done by taking an imposition prepared earlier.

" Use an existing PDF or XML file to control the hot folder

@ |se named automation sequences (compatible with Quite Imposing Plus)

Automation sequences

Category: IAulomation sequences LI

Name: |3 % 2 standard Ll
Search: | J

Created: 21 Feb 2025 18:00:58
Updated: unknown
Played: unknown [0 times)

‘You can create a new sequence by selecting commands, or you can do 'imposition by example’ by just importing
commands from any imposed file.

Tostart, click  Create new sequence... I of  Import/export... J

Manage automation sequences  Manage... | Edit... I Delete... | [delete sequence not hot folder]

Filter on filename

If you set a filter, the queue will check and only run files that match. If you have variables, you can also set
variables in the file name

Fiter: Setup... | Handles files: *-3by2*

Click Next to continue.

Back | Cancel [

#1 Modify 2 hot folder queue - 2 X

Automation sequences have a category and a name of your choice. The default category is
just “Automation sequences”, but you can create more categories to organise your work.

Normally this dialog is just used to select an existing sequence. But you have full control of
creating and editing sequences too, just as in the Quite Imposing Plus plug-in. Options

include

e Create new sequences — select imposition commands to make a new sequence from

scratch

e Import — create a sequence from an existing PDF document, or XML document, so

you don’t need to worry about keeping all your control files.

e Export one, some or all of your sequences into a new XML file. Note that if you
export more than one sequence into one XML file, you cannot use this directly as a

control file, but you can import the sequences back from it.

e Edit a sequence, by adding or removing commands, or changing options.

Quite Hot Imposing 6 Getting Started
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For more details on this, refer to the Quite Imposing Plus manual for automation sequences.

Other Setup Options

#1 Modify a hot folder queue - 3 X

{ . These are the final steps. You can enter a description for the queue and review the other selections. You can
k , also disable a folder here, so that it will not do any work until you enable it again.

Description
Description
Flatwork - 1218 Dynamic.xml 7 Locked

Summary

In folder: C:\Usershaandi\Desktophin

Out folder:  C:\Usershaandi\Desktopiout
Done folder: C:\Users\aandi\Desktophdone
Error folder:  C:\Usershaandi\Desktopherror

Control file: C:\Users\aandi\Downloads\Flatwork - 12x18 Dynamic.xml

Queue control
[” Enabled (ready to do work)

Wait time: |0 seconds (time to wait before a file is processed, can be 0)

Naming... | No prefix or suffix

v Allow job folders. (4 job folder is any folder dropped in the In folder. Al files are combined.)

Click Finigh to make these changes.

Advanced...
Finish I Back | Cancel [

The final setup dialog for a queue allows you to select further options.

The description of the queue. This will be shown on the main window. The description will
be filled in from the name of a setup file or stored sequence, but you can set it to something
that makes more sense to the operator of the software

The “enabled” switch. If you switch this off, the queue settings will be remembered, and the
queue will still be shown on screen, but it will not accept any work. If a queue is not enabled
it will have a different symbol on screen.

The “wait time” allows you to wait longer for a PDF file to be ready. This defaults to 0
seconds. If you set it for longer, then Quite Hot Imposing will ignore a file until it sees that
the file has not been written for that number of seconds. This may be useful if another
program is creating files in the IN folder, and does not do this all in one step.

The “Naming” button allows you to set a prefix or suffix (or both) as output files are written.
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“Allow job folders” means you can drop a folder into the IN folder, and the files will be
combined before processing. (If this option is off, folders are ignored. You cannot drop input
files into a subfolder to be processed).

The Advanced button allows you to set special options. The options are passed to the Quite
Hot Imposing command line, so almost all command line options can be unless they are
already set by the queue processing. Interesting options include

-jobname "string" — set a name for the job, which can be accessed by stick on text and
variables.

-fileinfo — show info on the input and output files in the log

-debugemdline — show the full command line used in the log

-timecommands — list a summary of each command processed and the time it took.

After you click Finish, the hot folder is ready for processing.

Setting a filename filter

Setting a filename filter is optional. If you do not set a filter, then the queue will handle all
the files you put in the IN folder. These allow the queues to choose work based on the

filename. For example, you could set up four queues on the same folder

1. Filter BOOK A4* (the asterisk * is part of the filter name). This picks up all files with
names starting BOOK A4 and does work suitable for an A4 book.

2. Filter BOOK A5%*. This picks all files starting AS.

3. Filter *MONTHLY*. This picks up all files whose names contain MONTHLY. It
won’t pick up the BOOK A4 and BOOK A5 files, since the first match found is the
one that is used.

4. Filter *. This picks up all files, or rather all the files not picked up by any other queue.

You can set filters in two ways. Firstly, they appear on the second setup screen (where the
sequence or XML file is chosen).
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O] Modify a hot folder queue - 2 N

. | The second step is to choose the work which will be done when a PDF file arrives in the ‘in' folder. This is
5 usually done by taking an imposition prepared eatlier.
" Use an existing PDF or XML file to control the hot folder

* Use named automation sequences [compatible with Quite Imposing Plus)

[~ Automation sequences

Category: IAutomation sequences

Name: IS&FI variable size

=l
=
Search: I _l Show a |

Created: 10 Jun 2024 21:22:03
Updated: 11 Jun 2024 09:14:56
Played: unknown (0 times)

‘You can create a new sequence by selecting commands, or you can do ‘imposition by example’ by just importing
commands from any imposed file.

Tostait, click  Create new sequence... | or  Import/export... I

Manage automation sequences  Manage... | Edi... | Delete... | (delete sequence not hot folder)

Filter on filename -

If you set a filter, the queue will check and only run files that match. If you have variables, you can also set
variables in the file name

Fiter:  Setup... I Handles files: 'BO0K A5*

E‘vck NE‘K[ IO COF Rmue.

Back Cancel

Click the Setup button to change the filter, or to remove the filter so all files are picked up.
You can also change the filter at any time using the pop-up action menu.
You can quickly check the filter, as well as other information like the input folder, by

hovering over the label at the right of the lines in the list of queues. A tooltip giving summary
information appears, as shown in this screen shot:
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1: Action.. Ready 2

2: Action...  Ready 1: S8R variable size3

3. Action... Disabled Ir?put folder: C\Usershaandi Desktopiin
Filter: FX*

4 Action... Broken Sequence category: Automation sequences

Sequence name: S&F variable size

The order of filters is important, since Quite Hot Imposing will check each one in turn until it
finds a match. You can add a final filter of just ‘*’ meaning “all other files’. You can use
Move in the Action pop-up menu to re-order the queues so the filters are checked in the right
order.

1: |Action.. Ready JS&RvariabIesize
2: Action... Ready  S&R variable size (2)

Enable

Disable

Setup...
Change automation sequence...

Change filename filter...

Delete...
Rename...
Duplicate...
Move > Move up...
Reset all counts Move down...
Move to start...
This i Show IN folder e
Show OUT folder 8 Quit. T - = I

Filters can also be used to set variables, a new advanced feature in Quite Hot Imposing 6.0.
For example a filter of *-<rows>-<columns> would pick up variables called ‘rows’ and
‘columns’ from a filename. This is described in detail in the separate documentation on
variables.

Deleting or Pausing a Queue
You can delete a queue by either of these methods

e Clicking the Setup button next to the queue description. A Delete button is shown
(this button is not shown when you first create a queue, only when running Setup
later).
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e Choose Delete from the action pop-up menu (eg click the Action button or right click
on the queue number or name)

When a queue is deleted, all the other queues after it will be renumbered. This should be
remembered when reading the log, which uses queue numbers to identify them.

You can pause a hot folder in several ways.
e Click the queue status button (showing Disabled, Enabled, Active or Broken).

e The third setup dialog allows you to turn off “enabled”. When a queue is not enabled,
it is paused.

¢ In the action pop-up menu you can choose Enable or Disable (eg click the Action
button or right click on the queue number or name)

You can also click the Pause button on the main window, if it is shown, or use Control >
Pause. This pauses all folders. When you click Resume, or use Control > Resume, processing
carries on. This is independent of the separate pausing of single folders.

For example, if queue 1 was active and queue 2 was paused before you click the Pause
button, all will pause. But when you click Resume, only queue 1 will resume, and queue 2
will still be paused

When a queue is paused, the work it is currently doing is allowed to complete. If you want to
force it to stop, click the Setup button, and you will be given that choice. (You will not be

able to change the setup while it is still working).

When a queue is shown as broken, it is because Quite Hot Imposing cannot continue with
that folder — not just because a job has had an error. A queue might be broken if

e Any of the folders it needs are deleted, renamed, or not available because a server is
down.

e The control file is unavailable, or the automation sequence is not found.

e After a job, Quite Hot Imposing is unable to move files, such as unable to move from
the IN folder to the DONE folder. It must stop in this case, otherwise it will keep
processing the same file. This can happen if

o File or directory permissions do not allow files to be moved, deleted or created.

o The file is in use; most often a file has been opened in Acrobat.

If a queue is shown as broken, trying to enable it will try again. If it fails again, check the
window for error messages.

Quite Hot Imposing action menu
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File Edit Control Help

: Quite

1: Ready S&R variable size3

2 Action... Ready  Dup pages 17 Good=2
3: Action... Disabled Generate bleed & booklet
4= - - - Good=0, |
Enable
Disable
Setup...

Change autormnation sequence...

Change filename filter...

Show DOME folder
Show ERROR folder

Bigger
Smaller

MNormal size

\#J Quite Hot Imposing — O X

Delete...

Rename...

Duplicate... .
Move N -03.pdf - perh
Reset all counts B

Show IN folder May 2025,

Show OUT folder I = |[=2

The action menu appears if you click the button marked “Action...” or also if you right click

on an item.

e Enable/Disable enables or disables this single queue. You can also enable or disable
by clicking on the status box (which says Ready, Working, Disabled or Broken).

e Setup runs the 3 setup menus which give access to all the options to set up the queue.

e There are two convenience items which give quick access to the most often needed
Setup functions: change automation sequence (or change XML control file); and

change the filter.

¢ You can delete or rename the queue.

¢ You can duplicate the queue. Normally you would then change the setup in some way

because two identical queues are not useful.

e You can move the queue up or down. This is useful if working with filters, as they are
checked in the order of the queues. You will need to restart Quite Hot Imposing after

you are finished moving queues.

Quite Hot Imposing 6 Getting Started
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¢ You can view the IN, OUT, DONE or ERROR folder in Windows Explorer or Mac
Finder.

¢ You can change the size of the display. The idea of this is so you can check on the
status of the work from further away.

Other Topics
Quitting Quite Hot Imposing

When you quit Quite Hot Imposing, the window will close, and all processing will stop. The
hot folder processing will not continue behind the scenes

Errors, Messages & Logging

The Quite Hot Imposing window includes an area where messages are added. Every file that
is handled will produce at least one message. When a file works, the message will be
something like:

1: Processed Large spread.pdf

The message starts with the queue number, and includes the name of the file. Note that
deleting a queue will not change the numbers shown for old messages.

If there is an error, there will be more than one line. For example

1: Failed, Tower pic.jpg moved to error.
1: ...** File does not begin with ‘%PDEF".

This error is in fact telling you that the file is not a PDF file at all, and this can be confirmed
by checking the file name: it is a JPEG.

If an error occurs on a PDF, it is likely to be caused either by a corrupted or damaged PDF, or
by a PDF with security settings. Quite Hot Imposing cannot make any changes to a file with
PDF security. (Acrobat’s File > Preferences will show security information under the
Security tab. To remove security, the file’s creator must usually tell you the password).

In some cases, warning messages or information messages will be issued for files that
succeed. These will come after the “Processed” message. The most common message is:

Warning, document contains bleed information, which has been used in layout (trim
box used).

You can remove this message in Preferences.

This happens when you process a file for which a bleed area (trim box/bleed box) has been
defined. You can remove this message by using preferences.
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Quite Hot Imposing also writes a log file, with all information from the window. (The
window only keeps a limited number of lines). The log file actually contains more
information, including the full name of each file processed, and the details of the settings
which were used in each case.

Preferences are available to choose the name of log files, and how long they are kept before
being overwritten. Only expert users will need to change this. The default will produce a
folder contain one log file for each day of the month, and which will be rewritten each month.

The preferences dialog also allows you to click an Open folder button to view the log file
folder in Windows Explorer or the Mac OS X Finder.

Preferences — Basic preferences

Quite Imposing Preferences can be reached by clicking the Prefs button, if shown, or using
Preferences from the menu (the menu is different in Mac OS X and Windows). These options
only apply when using Quite Hot Imposing in hot folder mode. They do not affect the

command line or Enfocus Switch.

You can switch between “basic preferences” and “imposition preferences”.

Preferences *

s (7 Impozition preferences

Screen format
¥ Show logo

v Show action buttons
Units of measurement |inches

Logging
Iv wirite log file(s)
Browse.. | Directory for loge C:AUsershaandivappD atatRoamingsQuitetLogsh

T
Log name |QuiteH ot.day<D>.log CihUsershaanditf

Special tags can be uzed in the name; <03 day of month; <M> month number; <> year; <F> gueus number

¥ Owenarite log files older than |5 days

Open folder | Yiew folder in Windows E splorer

Set language... | (] 4 | Cancel |

The first group of options allows you to control how much information appears on the main
window.

¢ You can choose whether the Quite Hot Imposing logo appears (to reduce screen
space)

Quite Hot Imposing 6 Getting Started Page 20



¢ You can choose whether the buttons appear along the bottom row. If you turn this off,
all the functions can still be reached from menus.

¢ You can choose the default unit of measurement eg inches, mm.

e For information on log file preferences, see Errors, messages and logging, above.
Note the Open folder button, allowing you to see the available log files in Mac OS X
Finder or Windows Explorer. Most users will not need to change these settings.

Preferences — Imposition Preferences

This information is an outline, since the options are the same as in the Quite Imposing Plus
plug-in. More details are available in the Quite Imposing Plus Guide (see the “Imposition
Preferences” chapter).

All of these options can be overridden on a per-imposition basis. To ensure that an imposition
never changes its effect, we recommend setting options per-imposition rather than relying on
preferences.

In command line mode, you must set any needed preferences on the command line. In
Enfocus Switch mode, you set these preferences for each step in a flow.

Preferences *

(" Basic preferences &

All of these preferences can be overidden for a single imposition.
Fiegistration mark colour when making colour separations)

* Al separations © CMYE © Black anly

FDF/= handling
Imposition can preserve PDFA4-1 and PDFA<-3 status

& lgnaore PDOFA O Preserve PDFA

Form fields and annotations
“Y'ou can choose to pregerve the appearance of annotations and form fields [flattened) or to ignare them in lapouts

& lgnore © Keep[fatten]
Bleed handling
YWhat to do if a bleed has been et 20 that trim bax iz not the same a3 crop box
" Usecrop ¢ Usebimbox © Prampt
Fage scaling [Uzerunit] handling
Fage scaling [UserUnit] allows larger pages than 200 inches/5040 mm, but may nat work with some apps and devices

" Allow page scaling O Forbid % 'WamAprompt

Set language... | Ok, | Cancel |

e Registration marks, added by N-up, Step & Repeat, Create Booklet or Manual
imposition may be placed on all separations, on the C=M=Y=K plates, or on the black
plate only.
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e If Preserve PDF/X is switched on, then a PDF/X input file will produce a PDF/X
imposed file. Certain restrictions apply. Version 3.0 supports PDF/X-1a. PDF/X-3,
PDF/X-4 and PDF/X-5.

e Form fields and annotation (comments) can be used to add to pages. Sometimes this is
just mark-up or instructions, not for final printing, and sometimes it is critical to print
it. If you choose Keep (flatten), the printable information will be preserved in
impositions (but will no longer be annotations or form fields).

e Bleed handling affects what is to be done when imposing a page that contains bleed
information (technically, a “trim box™ or “bleed box” which are not the same as the
“crop box”). The default option, “Prompt”, is taken from Quite Imposing Plus,
however, the standalone will not actually prompt; instead you will simply get a
warning message when any file is imposed that contains bleed information.

e You can choose whether to support large page sizes (using a feature called
“UserUnit”).
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